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Basic Interaction with Graphics
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Coordinate System
• WCS - World Coordinate System
• UCS - User Coordinate System

– Can be displayed at the origin on the model
– All points are input from this location

• When you start, the UCS is the WCS
• Relative to last input point done using @

– Input a point at 2,2,2
– A second point input as @4,0,0 will actually be 6,2,2
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ESC Key
• Cancels current operation
• Stops RadCAD calculations
• Resets the selection set to zero entities
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Object Snap
• Tools->Drafting Settings->Object Snap
• When prompted for point input, the cursor will 

highlight objects in the graphics area based on 
Osnap settings.

• You can Shift-Right click to change the settings 
in mid command.

• For center circle, select near the arc.
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Grip Point Editing
• Grip points are 

displayed for a 
selected item

• Each grip point 
performs a different 
function

Top radius

Start angle

Stretch Base

Top height

Align z axis

End Angle
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Views
• Multiple independent views
• Wireframe (regen)
• Hidden line (hide)
• Shaded (shade)
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Selection
• Command prompt will say

– Select Objects:
• To end the Select Objects Prompt, you must hit <Enter> or 

Right mouse click - MOST COMMON ERROR YOU 
WILL MAKE

• “ALL” will select all object not on frozen layers
• “P” will select the previous selection set
• “G” will allow the input of a group name
• “Remove” will allow you to deselect a selected item
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• Drag from 1-2 will select all objects that fall completely in the box.
– A and B will be selected

• Drag from 1-2 will select all objects that partially fill box.
– A, B, and C will be selected

• Input p to use the previously selected items

Selection

1

2

A
B

C

A
B

C

1

2
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Selection
• F - to select objects crossed by the fence

– Selects A,C
– not necessary to close polygon

• CP - to select objects crossed or enclosed by the 
polygon. 
– Selects A,B,C

A
B

C
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Layers
• A drawing can have many layers
• Each object resides on a single layer
• Each layer can be turned on/off or frozen

– An object will not be selected with “ALL” if on a 
frozen layer

– Objects are not considered for zoom all if frozen

• Layers can be locked – NOT RECOMMENDED
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Layer Form
New objects
will be on the 
current layer

Turn on/off

Freeze/Sun
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Points
• The user may create arbitrary points on the model 

using the Draw->Point->Single Point command
– Use PDMODE command to change the type of 

graphics object used to display the point
– Use PDSIZE command to change the size of points

• Must use regen for the PDMODE and PDSIZE command 
effects to be displayed.
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Rulesurf command
• Used to make surface from bounding lines

– Surftab1 parameter determines how many polygons are 
made. (default 6)

– Can then be converted to Thermal Desktop
• Surface or
• Finite Elements
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Useful Commands
• Right click repeats the last command
• ltscale

– sets the scale for the hidden lines
– lower value makes the lines more solid

• explode
– breaks a surface into more basic entities

• Cut and Paste
– You can cut/copy object from one dwg file and paste them into another

• Make sure both models are in the same model length units
• Must explode after paste because comes in as a group

• Changing the Background color
– Tools->Options, Display tab, colors

• Ctrl Z to undo

ltscale = .1 ltscale = .5
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Useful Commands (cont.)
• F2 Function key will bring up the text window in a 

scrollable format.
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Internal Error
• If you ever get a message that is something like:

– Internal Error: Database not open for write

• Quit immediately
– Do not save over your dwg file

• Might do a Save As to a new name
– If that new file loads, then you should be alright
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Toolbars
• Use the same commands as the pulldowns

– Can actually nest commands

• Cannot over emphasize the use of toolbars.
• You will be rewarded by taking the time to learn 

them
– Will work much faster

• Can be edited
• User can create
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Customizing Toolbars
• User can create their own tools bars



20

Customizing Toolbars
• To delete a single button off a toolbar, select 

View->Toolbars
– You can then select the button and drag it off a toolbar.  

Drag it into the graphics area and it will be deleted
• To reinitialize the Thermal Desktop toolbars, 

delete the following files in the installation 
directory
– thermal.mnc, thermal.mnr, thermal.mns

• The commands are actually stored in thermal.mnu
• Automatically done when you reinstall
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Screen Copy
• Best to use shareware programs

– HyperSnap - www.hyperionics.com
– Lview Pro

• Thermal->Utilities->Capture Graphics Area 
– Can paste into a document

• ACAD File->Export 
– Will not export the color bar

• alt-Print Screen and paste will allow you to paste 
into a document
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Process Priority (NT)
• Bring up the task manager

– Right click in open space of the taskbar

• Select the process to change
• Right click to set the priority
• Allows better system response for your interactive 

input while radiation calculations are being done.
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Starting AutoCAD
• Create a template

– Set your user preferences (first tutorial)

• Start AutoCAD by double clicking the drawing 
file
– If you start with the AutoCAD executable, you will get 

a warning saying the default directory is the AutoCAD 
installation directory
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Thermal Desktop
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Thermal Desktop Process
• Property Databases
• Build Geometric Model
• Radiation/Conductance/Capacitance calculations

– Output in SINDA format
• Build SINDA model
• Run SINDA
• Postprocess results
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Data Files
• *.rco file - ASCII file containing the optical 

property database
• *.tdp file - ASCII file containing the 

thermophysical property database
• *.dwg file - Binary file that contains all of the data 

that represents your model
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Output Files
• *.k - radiation conductors
• *.dat - view factor output
• *.hra - heating rate array data
• *.hrl - heating rate logic data
• *.cc - capacitance and conductance output
• *.rcf - view factor database
• *.rck - radk database
• *.rch - heatrate database
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Units
• User selects the units
• Can be changed at anytime
• All output and input are made in user units

– Internally, all data is stored in SI

• Changing the model length units will cause the 
actual geometry to be scaled
– A point at 1, 0, 0 meter will be at 100, 0, 0 when the 

user changes the length units to centimeters.
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Property Databases
• Thermophysical property and Optical property 

database names are stored on the dwg file.
• Default names

– RcOptics.rco for optics
– TdThermo.tdp for thermophysical

• ASCII files 
– You can convert existing databases this format

• Selecting OK from the edit form will save all the 
data of that database.
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Property Databases (cont.)
• Default name contains no directory information

– A copied dwg file to another directory will open 
databases in that directory.

• Use of Open Statement adds directory info to the 
name stored in the dwg file.  
– A copied dwg file to another directory will reference 

the same database.
– If the database is not found, then it will be opened in 

the default directory (same as dwg file).
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Property Databases (cont.)
• Thermophysical Database Properties

– If capacitance or density is zero, then nodes generated 
will be arithmetic.

– Units
• File is stored as SI (meters, Joules, seconds, Kelvin)
• Data is displayed in the user defined units

– Effective emissivity used to place MLI on surfaces
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Graphical Objects
• Can be surfaces, elements, nodes, heat loads, 

heaters, conductors, orienters, assemblies, trackers
• Can be edited with the Thermal->Edit command 

or 
• Can select more than one object for editing 

(MultiEdit mode)
– Only one type of object can be edited at a time 

(ie. 2 surfaces, but not a surface and a heatload)
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Graphical Object Visibility
• 3 ways to change the visibility of an object

– Preferences form, Graphics Visibility can globally turn 
off Nodes, Heat Loads, contact, and orienters

– Change the layer visibility
– Change the visibility of the object with the Modeling 

Tools->Turn Visibility On/Off
• To see an object both the layer visibility and the objects 

visibility must be on
• An object is off if either the layer is turned off or the visibility 

of the object is turned off
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Nodes
• Can be created with Thermal->Network->Node 

command
• Can be “attached” to geometry or be “free”

– Attached node type (diffusion or arithmetic) will be 
determined by the material properties of the surface/s 
making up the node

• Thermal->Preferences command, Graphics 
Visibility Page
– Globally turned off
– Can change size
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Nodes - cont.
• Displaying Node Numbers

– Numbers are an attribute of the node
– Node layer must be on to see the node
– Preferences specifies the height to be a percent of the 

graphics size, or a fixed height
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Surfaces
• Created with Thermal->Surfaces->* command

– Cone, Cylinder, Disc, Paraboloid, Polygon, Rectangle, 
Sphere, Ellipsoid, Elliptic Cone, Elliptic Cylinder, 
Offset Paraboloid

– From AutoCAD Surface

• All surfaces have nodes attached
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From AutoCAD Surface
• AutoCAD meshes can be converted to Thermal 

Desktop surfaces
– Rulesurf
– Box
– Lines of Extrusion
– Lines of Revolution

• Thermal->Modeling Tools->Toggle Mesh 
Nodalization command can be used to break each 
polygon into a single node
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Planar Elements
• Triangular and quad elements supported
• Must create the nodes before the elements
• Thermal->Network->Convert AutoCAD Surface 

to Nodes/Elements
– Converts mesh to nodes and elements
– Line of revolution
– Line of Extrusion
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Surface Properties
• Can be double sided

– Different node numbers on each side and conduction 
through the middle

• Can edit node numbers from surface properties or 
the node edit form
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Surface and Element Properties
• Cond/Cap data

– Have a material and a thickness
– Must have Generate Cond/Cap checked in order to get 

the node data in SINDA output

• Optical Properties for each side
• Edge contact conductance
• Area contact conductance
• Insulation/MLI placed on either side
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• Conductor based on the insulation material properties
– If effective emissivity > 0, you get radiation conductor
– If conductivity, thickness > 0, you get a linear conductor
– If both > 0, you can get both radiation and linear conductor

• Conductors/Nodes  are generated with Cond/Cap Calculations
• All radiation analysis goes to the new MLI node
• Note the advantage of this being area based, when you change 

the size of the surface, all you do is reoutput the condcap data. 

MLI/Insulation

Place MLI
on the Top Side

MAIN.1 MAIN.1 MAIN.10001

Edge View of Surface Actual nodal model
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Solids
• FD Solids

– Brick (orthogonal), Cylinder, Sphere
– Nodal breakdowns in 3 directions
– Radiation from sides
– Contact from sides

• Finite Element
– Tetrahedron, Wedge, Brick (non orthogonal)
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• Radiation/Area Contact conductance can be 
applied by surface coating the free solid 
faces (Thermal->Network->Surface Coat 
Free Solid Faces)
– Make sure thickness is zero if only for coating

Solid Elements

Surface coated quad element allows radiation off that face
Uses the same nodes as the brick
Generated so that top side is out
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Solid Generation Techniques
• Extrude 2d surfaces/elements into solids

– Use edge nodes on surfaces

• Revolve 2d surfaces/elements into solids
• Map Mesh a solid between 2 surfaces

– Must have same nodal breakdowns

• Import from NASTRAN, IDEAS, and FEMAP
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Assemblies
• Thermal->Articulators->Create Assembly 

command is used to create an assembly
• An origin is input and the axis are drawn on the 

screen
– Red is X axis, Green is Y axis, Blue is Z axis (RGB)

• Geometry is attached to an assembly
• Assemblies can be attached to other assemblies 

and can be nested as deeply as desired
• Can be used to move or realign the group of 

objects
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Conductance
• Edge contact
• Area contact
• Conductors between nodes on an object
• Conductors between nodes on different objects
• Finite Element Conductance
• User Conductors
• Contactors
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Edge Contact Conductor
• Can be edge to edge or edge to area
• For example, a circuit board to a casing
• Input data on contact page of edit form
• Edge contact is shown by a half 

cylinder on the edge
• Nodes do not need to be aligned
• Parameters are on the Cond/Cap Calc-

>Set Cond/Cap Parameters
– Contact Integration Levels
– Tolerance
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Area Contact Conductor
• For a chip on a circuit board
• Input data on contact page of edit form

– Can verify with Model Checks->Display Active 
Sides/Preferences

• Nodes do not need to be aligned
• Parameters are on the Cond/Cap Calc->Set 

Cond/Cap Parameters
– Contact Integration Levels

tc

tb

= tc/2 + tb/2
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Contactor
• User selects which surfaces to contact from 

and which can be contacted to
• Can be Area or Edge
• User defined tolerance
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Conduction between same object
• Finite Difference approximations
• Must be broken down in either direction
• Either centered nodes or edge nodes

– Edge node span the entire boundary
• No extrapolation
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Inter Object Conduction
• Must use edge nodes
• Nodes must be merged (Thermal->Network-

>Merge Coincident Nodes)
– Editing one node id will always edit the other

• Use Thermal->Model Checks->Show Free Edges 
– Draws a red line on faces on edges shared by 1 set of 

nodes

Each surface is broken up 6 angular 
and 2 in the height
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• Galerkin partial differential equation 
used to solve conductance
– Series of equations are output in SINDA 

conductor format for solving in SINDA
• The SINDA conductor from 1-2 does not 

represent the heat transferred from 1-2, it is 
represented by all the conductors from element 
1,2,3

– Like conductors are summed before input 
in SINDA

• Conductor between 2-3 will be the sum from 
element 1,2,3 and element 2,3,4

Finite Element Conductance

1

2

3

4
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Finite Element Conductance
• Many finite element operations are supported

– Merge Nodes
– Show Free Edges
– Show/Hide solid interior faces
– Surface Coat Free Solid Element Faces
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Node-Node Conductors
• A conductor may be input between 2 nodes

– Can represent anything the user desires
– Can be material dependent (for the conductivity)
– Can be radiation
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Node to Surface Conductors
• Can be used to represent:

– Convection
– Ern Nodes

• Node must be selected first
• Can be per unit area
• Can be radiation
• Can be material dependent
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Contactors
• Contact a group of surfaces to another 

group of surfaces
• User controlled tolerance and integration 

levels.
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HeatLoads/Heaters
• Thermal->Network->Heatload or Heater command
• Can be applied to surfaces or nodes
• Heatloads

– Can be a flux
– Time Dependent
– Area distributed values

• Heaters
– Can have different sensor nodes than where the heat is applied
– Input power, and on/off temperatures
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Model Browser
• Thermal->Model Browser
• Allows the user quickly scan through the 

entities defined in a model and edit them
• Options include

– Display only that item
– Display node number
– Turn visibility on/off for selected item
– Editing
– Deleting
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Model Checks (cont.)
• Thermal Modeling Checks->Color by 

Property Value->*
– Thermophysical props (k,cp,density)
– Optical props (emiss, alpha, trans, etc.)
– Insulation/MLI k*, e*
– Edge contact conductance
– Area contact conductance
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Post Processing
• Thermal->Post Processing->Manage Datasets

– Each dataset defines the data file type
• SINDA SAVE, Form Factors, Radks, Heating Rates, ASCII

• Can use Next Time and Previous Time to step
– Also Next/Previous position for use with trackers

• Modify Color Bar
– AutoScaling, Text Label
– Must switch to paper space to move/change color bar 

and windows (Orbital Heating Rates tutorial)
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Post Processing (cont.)
• Post Processing viewport has own view defined

– regen, dview/zoom/pan, shade to change the view 

• Contour Plots
– Finite Elements are contoured

• Plot Current DataSet vs. Time command allows 
selecting the nodes and plotting the transient 
(Beta)
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Importing
• TRASYS
• TSS
• Nevada
• STEP-TAS
• IGES

– Command is IGESIN
– What you get is a function of where the file 

comes from
– Sold as a separate item

• NASTRAN
• IDEAS Universal
• FEMAP
• STEP-209
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Exporting
• TRASYS
• TSS
• STEP-TAS
• STEP-209
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Model Mapping
• Need temperature data for locations that you don’t 

have a node.

Thermal Model Structural Model
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Model Mapping (cont.)
• Use Map Data to NASTRAN command if you 

have a NASTRAN file
• Use Map Data to Locations command to map the 

data to locations found on an ASCII file
– Submodel.Id   x   y   z

• Use Write Node Locations to write out the node 
locations
– May have imported IDEAS Universal file
– Built FE model by hand in Thermal Desktop
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Case Set Manager
• Can take the model from geometry to 

temperatures with one command
– Calculate Radiation

• Automatic restart determination

– Calculate Cond/Cap
– Build a SINDA model

• Only for simple type runs with limited operation logic
– Steady State or Transient

– Run SINDA from within Thermal Desktop
– Post Process Results
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Introduction to RadCAD

Radiation Analyzer
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Capabilities
• Monte Carlo Ray Tracing (MCRT)
• Oct Cell Acceleration
• True curved geometric surfaces
• Transparent and Specular properties
• Angular dependent properties
• Sun/Planet/Star Tracking Surfaces
• Display model in Orbit
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Analysis Groups
• Allows the user to break a model into multiple 

radiation analysis “jobs” based on  prior 
knowledge of no radiation between the groups (ie. 
Internal enclosures are a good example )

Inside might be “Enclosure A”

Inside might be “Enclosure B”

External Surfaces
would be in group
“External”
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Analysis Group
• Why is this an advantage?

– One file vs. three makes reduces chances of 
bookkeeping mistakes

– 3 separate jobs will run faster and use less disk space 
than one large job
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Surface Properties
• Different Optical Properties for each side of a 

surface
• A surface can be present in more than one analysis 

group. For example, the top side may be in 
External, while the bottom side may be in Internal
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Active Side Verification
• Thermal->Model Checks->Display Active 

Sides command
– Green - Side seen is active and opposite side is 

inactive
– Blue - Side seen is inactive and opposite side is 

active
– Gold - Both sides active
– Dark Blue - Neither Side Active
– Red - Not in the analysis group
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Active Side Verification (cont)
• Active Display Preferences

– Shaded mode
– Arrows
– Can also show MLI surfaces and surfaces with 

area contact conductance
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Orbits
• Several Types Supported

– Basic 
• Circular Orbit given altitude and beta angle

– Keplerian
• Full Orbital Parameter input 

– Geo Latitude, Longitude, Altitude
• Weather balloons, objects on the planet

– Vector List
• Input time, sun/planet vectors, distance from planet
• Used for trajectory type analysis

– Free Molecular Heating
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Orbits (cont.)
• Thermal->Orbit->Manage Orbits
• Thermal->Orbit->Edit Current Orbit
• Thermal->Orbit->View From->*

– Sun, Star, Subsolar, Planet North, Vernal 
Equinox, Ascending Node, Orbit Normal
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Displaying the model in Orbit
• Thermal->Orbit->View Vehicle->*

– Set Orbit Position/Prefs
• Allows the user to scale the model

– Next Position and Previous Position allow the user to 
move the model around the orbit

• Hint:: You can right click to repeat the last command
• Also, the toolbars work well for this
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Model Viewing
• Thermal->Model Checks->View Model from 

Sun/Planet
– Displays only the model (not the orbit)
– Good for checking trackers
– Good for orienting trackers when post processing 

SINDA data
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Trackers
• Allow surfaces of your model to track the planet, 

sun, or a star
• Thermal->Articulators->Create Tracker

– Can be active always, in shade, in sun, between user 
input orbit positions

– Surfaces are attached to a tracker
– Trackers can be nested
– A surface can be attached to more than 1 tracker
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Trackers
• Allow user specified range of motion
• Color coded

Color Coded Pointer:
White/Black for Star
Blue for Planet
Yellow for Sun

Arc shows range of motion
In this example -90 to 90
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What is a radk?
• Used to determine the radiative energy 

transferred between two nodes.

– is the Stephan Boltzman constant
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Ways to calculate radks
Calculate View Factors

•Monte Carlo
•Nusselt Sphere(TRASYS)
•Contour Integral(TMG)
•Hemi Cube(TMG)

Radiosity Solution
•Progressive(RadCAD)
•Gebhart(TRASYS,TMG)
•Oppenheim(TMG)

Radks

Calculate Radks
•Monte Carlo
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Radiosity vs. Direct Radk Calcs
• Radiosity

– Advantages
• Fast
• Can save disk space for heatrate calculations

– Disadvantages
• Energy assumed to be equally distributed about a 

surface(must build model with this in mind)
• Cannot handle specular and transmissive properties



83

Calculating Radks
• Setup the run

– Current Default Analysis Group
• Thermal->Radiation Analysis Groups

– Current Default Orbit (if created)
• Thermal->Orbit Set Current

– Thermal->Radiation->Set Radiation Analysis
• Control - Number of rays, energy cut off, oct cells
• Output - Filenames, starting ids, cutoff factors
• Nodes - Specify specific nodes to be calculated
• Positions - Set positions to be calculated
• Ray Plot - Plot the calculated rays on the model
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RadCAD Calculations
• Thermal->Radiation->Calc *

– View Factors
– RADKS from View Factors

• Progressive Radiosity Solution
• View Factors must be calculated first

– RADKS Ray Trace
– Heating Rates Direct/VF

• Progressive Radiosity Solution
• View Factors must be calculated first

– Heating Rates Ray Trace

• User will be prompted to verify the analysis group and 
orbit, if necessary
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RadCAD Calculations
• If a database already exist, a test will be performed 

to determine if a restart is possible.  If it is 
possible, you will be prompted to replace the 
database or append results.
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RadCAD Calculations
• Case Set Manager

– Allows setting up all the different analysis group and 
orbit combinations

• Stores the input/output data for each “job”.  
– Number of rays, oct cell levels, output filenames, etc...

• Can solve all jobs with the click of a single button
• Default is to REUSE the radiation calculations if nothing has 

changed in the model.
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MCRT Methods
• View Factor

– A view factor, Fij, represents the fraction of energy that 
leaves surface i and is incident on surface j.

• Interchange Factor
– The interchange factor, Bij, represents the fraction of 

energy that leaves surface i and is absorbed at surface J, 
by all possible paths.
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View Factor Calculations

1

2

3

4

Fij = Number of rays from Node I that hit Node j
Total Number of rays shot from Node i
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View Factor Calcs (cont.)
• View Factors sum to 1
• Reciprocity is not enforced

– FijAi != FjiAj
– Always approached as more rays are shot

• How is each ray shot?
– Random starting location on a surface
– Random angle from the surface
– Intersection test to other surfaces in the model
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View Factor Calcs (cont.)
• Starting Location

– Must have equal distribution per unit area
– For a rectangle with origin 0,0

• X start = len * random
• Y start = h * random

– where random is a number between 0 and 1

x

y

h

len
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View Factor Calcs (cont.)
• Starting Location (cont.)

– For a disc centered at 0,0

• In polar coordinates
– R^2 = r * r * random
– a = 2 * pi * random

x

y

R
a

r
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View Factor Calcs (cont.)
• Starting Angle

p

Top View

t cos2t = random

p = 2 * pi * random
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View Factors Cont (cont.)
• Intersection Tests

– Performed with every surface in the model
• Classical solution, Oct Cells changes this

– If there is a hit, determine the distance to the surface
• Why you can’t have surfaces in the same plane

– Smallest distance is determined to be the first surface 
hit
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Oct Cells
• Oct Cells breaks the model down into regions so 

that smaller number of intersection tests may be 
performed

• Oct Cell acceleration does not change the results, 
only arrives at them faster.
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Oct Cells (cont.)
• 2D Oct Cell Example

– Create a bounding box around the model
– Subdivide the cells (Example 3)
– Determine which surfaces are in which cells
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Oct Cells (cont.)
• Consider a ray from surface 1

– Perform self hit test
– Intersection test to #2
– Ray Propagated through empty 

cells
– Intersection test with #3
– Intersection test with 3+4
– Hit on 4 is found

1

2

3

4
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Oct Cells (cont.)
• Calculating the cells takes CPU time

– Made up for in shooting the rays faster
• Increasing the subdivisions

– Takes longer to calculate the cells, usually a factor of 4
• Amazing how fast this is

– Requires more memory
• Default subdivisions is 5

– Usually <= 9. 
– 10 may run you out of memory.

• Optimal number of subdivisions and surfaces per 
cell are model dependent
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Oct Cells (cont.)
• Look at varying the subdivisions for the tetra 

model

Subdivisions CPU Time *faster Cell Time

None 43.21

1 35.58 1.21

2 19.52 2.21

3 10.27 4.21

4 8.61 5.02 .03

5 8.29 5.21 .13

6 8.17 5.28 .47
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Oct Cells (cont.)
• OptimizeCells command

– Shoots 100 rays per node
– Resets the random seed so same rays are shot each time
– Varies the subdivisions from 5 to 8
– Varies the surfaces per cell from 8 to 12
– Projects results out to 5000 rays to determine optimal 

subdivisions and surfaces per cell
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Interchange Factor Calculations
• Starts same as view factor
• Set the energy Eray = emissivity
• Determine the first hit surface
• Get the properties of the surface

– Emissivity and transmissivity
– Can be dependent on incident angle

• Determine how to reflect the ray
– Dependent on transmissivity and specularity

• Adjust Energy of the ray
– Eabsorbed = Eray * emissivity of surface hit
– Eray = Eray - Eabsorbed

• Re-emit the ray from the hit surface
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Interchange Calc (cont.)
• How does a ray stop?

– Completely absorbed by hitting a surface with emissivity = 1.
– Ray goes to space

• No surfaces hit

– When the ray energy percentage is less than the energy cutoff 
factor, the ray is either completely absorbed or completely 
reflected, based on a random number and the emissivity of the 
surface hit.

e = .4

Incoming ray,
Eray = .05%

Energy cutoff = .1

random <= .4 ray is completely absorbed
random > .4   ray is completely reflected
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• The interchange factor from the emitting node to 
every other node can be calculated by:
– Bij = Energy Absorbed by J
– Energy Emitted by I

Interchange Factors (cont.)
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RADKS
• Radk = eiBijAi

• Interchange factors are calculated twice, once 
from node i to j and once from node j to i
– Radks are combined with a weighting scheme to the 

more accurately calculated RADK.
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RADKS
• Radks with Bij or Bji > Bij cutoff are output to 

SINDA
• At the bottom of the radk output file will be the 

summary information for the output radks
– The “List if %kept is off by more than” parameter can 

be used to minimize the output so that only values in 
error are printed.
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Heating Rate Calculations
• Random starting location on a surface
• Shoot ray towards the source

– As opposed to shooting a bunch of rays from the source

• Determine if a ray can see the source
– Direct Incident calculation

• Absorb energy at the starting location
• Propagate the ray same calculating radks
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Heating Rates (cont.)
• Absorbed Energy is comprised of two components 

– Direct Absorbed is the amount of energy absorbed from 
the direct incident calculation for that node

– Reflect absorbed is the amount of energy absorbed 
from the reflection off of other surfaces

• To improve accuracy, more rays must be shot from the surface 
that gets the incident heat from the source

Earth

1

2
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Progressive Radiosity
• Calculates interchange factors from view factors

– Heating rates from direct incident and view factors

• Advantages
– Faster to calculate view factor than radks
– Heating rate reflection matrices are not recalculated every 

source/position
• Less Disk Space

– Loss this advantage if geometry is moving

• Disadvantage
– Assumes energy is equally distributed about a surface

• People have lived with this assumption for years with TRASYS
– No specular reflections
– No transmissive surfaces
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Progressive Radiosity (cont.)
• Uniform distributed energy assumption

Consider Incident Energy

Radiosity distributes the energy
to be reflected over surface 1,
thus over predicting the energy
going to 2.

MCRT reemits the energy
from the hit point, thus correctly
predicting the energy at 2

1

2

1

2

1

2



109

Progressive Radiosity (cont.)
• A good test to determine if a model is good for 

radiosity networks is to calculate the radks using 
radiosity and also using MCRT and to compare 
them.  Large differences in the radks will require 
model refinement before progressive radiosity is 
begun.
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Error Estimation
• Before any discussion on error estimation is 

considered, you must be aware that energy is 
always conserved in MCRT.
– Bij sums are always around 1.

• This is comparable to the RKSUM used to verify TRASYS 
models.

– If a radk is a little high in one location, it will be a little 
lower in another to compensate.

• Best way to get comfortable on how many rays to 
check out the temperature differences as you shoot 
more rays.
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Error Estimation
• MCRT is a statistical process
• Each radk has an error associated with it.

• 1.645 is a 90 % confidence interval

% error = 100. * 1.645 * 1 - Bij 
#rays*Bij
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Error Estimation (cont.)
Number of rays

1K 2K 5K 10K 20K 50K 100K 1M

.001 164.5 116.3 73.5 52. 36.8 23.3 16.4 5.2

.002 116.2 82.2 52. 36.8 26. 16.4 11.6 3.7

.005 73.4 51.9 32.8 23.2 16.4 10.4 7.3 2.3

.01 51.8 36.6 23.2 16.4 11.6 7.3 5.2 1.6

.02 36.4 25.8 16.3 11.5 8.1 5.2 3.6 1.2

.05 22.7 16.0 10.1 7.2 4.9 3.5 2.2 .7

.1 15.6 11.0 7.0 4.9 3.5 2.2 1.6 .5

.2 10.4 7.4 4.7 3.3 2.3 1.5 1.0 .3

.5 5.2 3.7 2.3 1.7 1.2 .7 .5 .2

Bij



113

Error with TRASYS
• Not intended to be a put down TRASYS section.  

This is so people can realize that previous methods 
also had error, and the cumulative results were 
acceptable.

• These examples all came from existing TRASYS 
models while comparing results to MCRT.
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Error with TRASYS
• Direct View Factor Calculation Error

L

d

d

L/d Closed TRASYS %Error
10. .2819 .3805 35.0
6.7 .2765 .3498 26.5
6.6 .2763 .2731 1.2
1. .1998 .2000 0.1
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Error with TRASYS
• Shading Calculation

1
2

3

All Surfaces 1x1

d MCRT TRASYS %Error
1.5 .01871 .01689 -9.8
1.9 .02315 .01284 -44.5
2.1 .02399 .03447 +43.7
2.5 .02317 .02719 +17.3

d
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Error with TRASYS
• Radiosity Solution - Propagated Errors

1

23
Infinitely long
VF1-2=VF2-3=VF32=.5
e = .3

B11 = .259
B21 = .370
B31 = .370
RK Sum = .999

Change View Factors to be off by 2% or .49

B11 = .239 7.7% error
B21 = .349 5.7% error
B21 = .349 5.7% error
RK Sum = .937
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How many rays to shoot
• For initial runs and debugging of models, only 

shoot about 2000 rays.
• For final runs, 5-20K rays should be considered.

– Remember that rays are cumulative, shoot 2K the first 
time, and add more to them.  Check the temperatures, if 
they change significantly, repeat the process.  You will 
develop a keen sense of how many rays is best for your 
type of models over time.


